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1 Overview 

 

The Banker’s Dashboard forecasting tool provides users the ability to create short-term 
forecasts and budgets by analyzing current and recent past income and expenses. The 
system calculates and presents data in a detailed, month-by-month, G/L account format 
and allows users to apply different scenarios to those calculations to help them with 
strategic planning and budgeting. 

Budget/Forecast reports are viewed using the same GL tab reports used for analyzing 
actual data. Users can compare results against actual data or against other scenarios. 

 

2 Before You Begin 

 

 
This section defines the actions you should take prior to opening the tool and beginning 
the process of building a new project. 

 

There are a few things you must consider before you begin using the forecasting tool. 
Reading this section and following the suggestions below will help ensure that your 
forecasting project gets off to a good start and will help you avoid constant reworking of 
your forecast. 

 
2.1 Information Gathering 

 
The first step in creating your forecast is to know your financial institution’s forecasting 
goals. It is difficult to proceed with building a successful forecast if you do not have a 
clear picture of the institution’s overall fiscal goals. Information gathering is, therefore, a 
vital part of building a useful forecast. 
 
Prior to beginning the actual process of building your forecast using the Banker’s 
Dashboard tool, you should have a well-defined set of institutional goals. The more 
information you have before creating the new forecasting project, the easier and more 
efficient the process will be. When developing this information, consider anything that 
may occur during the next 12 to 18 months that could affect the institution’s overall 
financial position. For example, some of the questions you may ask yourself, or your 
board are: 
 

 Do we want to grow or shrink? 

 Will we be opening or closing any branches and/or hiring any new employees?  

 Do we want to sell off or purchase property? 

 What do we believe rates will do in the near future? 

 How will changes in rates impact our financial goals? 
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 Do we have any large expenses that will roll off, or for some reason do not 
recur? 

 Are there any large loans that will renew or reprice? 
 
These are just a few of the questions you should consider prior to creating your new 
forecast. It is also helpful to consider any goals set by the institution’s board when 
building your project. For example, are there any board plans that my affect the 
project’s targets?  

2.1.1 Using the Dashboard for information gathering 

 
Do not disregard the importance of this process. You must understand the institution’s 
financial goals before creating a proper forecast. Fortunately, the Dashboard can help 
you. 

 

For example, using the Loan Maturities, Loan Repricing, and Prime Rate Shock tools 
under the A/L tab can help you gather information about your loan portfolio and assist 
you in making decisions regarding questions such as: 

 
Fig. 2a 

 Where is the floor in my loan 

portfolio? 

 How much can rates rise before 

they begin to affect my interest 

income? Or, 

 Will a rise in rates benefit the 

institution? 

 

Additionally, using the Monthly CDs, Maturities, and Maturity Rate Change tools 
located under the CDs section of the A/L tab will help you gather information regarding 
high rate CDs that are going to reprice. 
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It may also be helpful to view and analyze the 
Maturities report located under the 
Summaries section of the A/L tab. 
 
Note the bars in this report represent volume 
and the lines represent rates and yields. 
 
To further analyze the results, you can also 
click on the graph to drill down and 
determine the accounts behind each number 
(by clicking on the dots on the line graph, for 
example). 
 

 
                                                                                                  Fig. 2b 

Once you have gathered all the information you need, proceed to the next section for 
directions on how to ensure that all accounts are mapped properly in the G/L section of 
the Dashboard prior to building your forecast. 

 

2.2 Account Mapping 
 
The next step you must take prior to creating a budget or forecast is to ensure that all 
accounts are mapped correctly in the G/L mapping section of the Admin tab.  

Note: If you do not have an Admin tab, see your institution’s Dashboard administrator. 

Here you must check the I/S Acct and Fee Acct columns (see Fig 2c) and ensure that, 
each interest-earning asset is mapped to the correct interest income account: And that 
each interest-bearing liability is mapped to the correct interest expense account. The 
Dashboard uses these settings during the forecasting process to calculate any rate 
assumptions you provide when building your forecast. Correctly identifying these 
accounts ensures that those assumptions are calculated using the proper interest 
income and expense against the proper account balances. 

This is a vital step and is especially important for new Dashboard customers.  
 

 All users should check their mapped accounts prior to creating a forecast 

to ensure any new accounts that may have been added are mapped correctly, or that 
any recent changes are properly represented. 

 

2.2.1 To check your current mapping settings: 

Navigate to the G/L Mapping section of the Admin tab. Click on the Assets tab and the 
Liabilities tab to view and make changes to the I/S Acct and Fee Acct settings. 
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Fig. 2c 

 

 

Accounts that have already been mapped 
will appear as green with blue numerical 
text representing the account number. 

Fig. 2d 
 

If a new account has been created, but 
has not yet been mapped, it will appear 
pink. 

 Fig. 2e 
Blank rows are non-interest earning/ 
bearing accounts. 
 
Note: It is okay to leave cells that appear pink 

or blank as they are, so long as you determine 
they are not interest earning or bearing 
accounts (i.e. non-post, clearing, suspense, 
and WIP accounts). 

 Fig. 2f 

 

2.2.2 To map an account: 

Under the G/L Acct column (see Fig. 2c), click on the account name that you would like 
to map. This will open the GL Account Mapping window. 



 7 

 

Fig. 2g 

In the box beside I/S Account find and click on the account where you would like to 
post the interest income or expense. Once selected, the account will be highlighted in 
blue. If you are working with loans and would like to select a fee account (optional), find 
and click on the account in the box beside Fee Account to highlight it.  

Note: The Fee Account field gives you the option to budget fees as a percentage of 

loan(s). This field is optional as some institutions do not budget loan fees, or budget them 
as a dollar amount instead of a percentage of loans. 

If you have more than one interest account that contributes to the balance sheet 
account and would like to select multiple accounts, you can hold down the Ctrl key and 
click on any accounts that apply to highlight them. Banker’s Dashboard recommends 
that, whenever possible, a separate interest account exists for each balance sheet 
account. This makes for cleaner data and easier analysis. 

Note: If the interest income or interest expense account desired is not listed, go to the 

Income or Expense tab under Account Mapping to ensure that the accounts are mapped 
correctly under income/expense Dashboard groups. Once the income/expense group has 
been updated, return to the asset/liability group and the account should appear in the I/S 
account box. 

If you choose to change any settings in your g/l account mapping during the budgeting 
process, you must re-sync your data in order for your project to reflect those changes. For 

more information on syncing data, see section 4.2.3.2. 

2.2.3 Verify Allowance for Loan Loss Accounts 

The next step in the mapping process is to ensure that you have a Current Year Provision 
account (which represents your monthly adjustments for the current year) and a 
Balance-Beginning-of-Year account (which represents your cumulative provision up 
through the end of the prior year) mapped to your balance sheet. 

 
Two separate G/L accounts must be mapped to each of these Dashboard groups in 
order for the forecasting tool to work properly. 
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To verify the settings for these two 
accounts, navigate to the G/L tab, click 
on Balance Sheet, and then click on 
Compare. 
 
This will open the Balance Sheet 

Compare window. 

 
                                       Fig. 2h 
 

 

Fig. 2i 

Select the appropriate options and click on Show Report. This will open your balance 
sheet. 

When viewing your balance sheet, 
click on Less: Allowance for loan 

losses.  

 

This will open the Less: Allowance 

for loan losses Group Drill Down 
(see Fig. 2k). 

 
Fig. 2j 

 
Click on Balance – Beginning of year and Current year provision (see Fig. 2k) to view 

any mapped accounts. Accounts must be mapped here to budget your allowance. 

 

 

Fig. 2k  
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To see more detail regarding the 
mapped accounts, you may also click 
each account to view how they relate to 
individual profit centers (see Fig. 2l). 

  
                                    Fig. 2l 

 

If they do not already exist, it is also recommended that you create accounts for 
Charge-offs and Recoveries. Breaking these two items into their own accounts allows 
better insight into what the ALL monthly adjustments should be.  

If you do not have G/L accounts mapped to all of these lines, follow the instructions in 
section 2.2.1 to return to the G/L Mapping area of the Admin tab. 

Once you have gathered all of the information necessary and have verified and/or 
corrected all account mapping, you are ready to proceed with creating your forecast. 

 

3 Creating a New Forecast 

 

 
Before you proceed, refer to section 2 of this document to ensure that you have gone 
through the steps necessary to successfully create a forecast. There are some vital steps 
in making sure that the Dashboard is properly set up to create a forecasting project and 
they are covered in section 2 under “Before you Begin.” 

 

Once you have gone through the steps in section 2, you are ready to begin creating a 
new forecast. 

To create a new forecasting project 
open Bankers Dashboard and navigate 
to Projections, and click on Forecasting.  
 
This will open the Forecasting window 
(see Fig. 3b). Here you may create a 
new project, or open an existing 
project. 

    Fig. 3a 
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Note: If you’d like to open an existing project, select it using the drop down menu under SELECT 
PROJECT (see Fig. 3b). Once you have highlighted the project, click on Open Project and skip to 

section 4 of this document for help with the Banker’s Dashboard Forecasting window. 

3.1 Create a New Project 

To create a new project, click on 
Create New Project. 

 

This will open the Create New 

Forecast window (see Fig. 3c). 
 

Fig. 3b 
 

 

Start 
 

 Fig. 3c 

Enter a name for 
your forecast in the 
box beside Name. 
 
To copy an existing 
project and use it to 
build the 
foundation for your 
new project, you 
can select it by 
using the drop 
down menu titled 
Current Project. 

Click the 
 
arrow to proceed to the next menu. 
 

 General  
 
Select whether 
you’d like to create 
a By Center or 
Total Bank project. 
 
A Total Bank 
project creates one 
worksheet for the 
entire bank. While a 
By Center project 
will allow you to 
budget for all of 
your current profit 
centers. 

  Fig. 3d 

 

Note: This cannot be changed once the project has been created. 



 11 

 Use the drop down menu beside Primary Profit Center to select your primary profit 
center. This is the center where all capital entries are made in a By Center project. 

 Click the 
 
arrow to proceed to the next menu. 

 

Cash 

Fig. 3e 

Use the drop menu 
under Cash 

Balancing Account 
to select where the 
system will post the 
plug to balance 
your forecast. 
 
Select the primary 
retained earnings 
account using the 
drop down menu 
under Retained 

Earnings Account.   
Note: In order to see the correct plug balance, it is recommended that you choose G/L accounts 

that are not currently in use. 
 
By Center Only: When creating a By Center Forecast, you will be given the option to Balance 
cash at each profit center. If you select No, the balancing amount is posted to the account at the 

primary profit center. 

 
Click the 

 

 

 
arrow to proceed to the next menu. 

 

Loan Loss 
Allowance 
 
Select the 
Beginning of Year 

Balance Account, 
Balance Sheet 

Provision Account, 
and Income 

Statement 

Account. 
 
These options will 
determine where 
the monthly 
adjustment to loan 
loss allowance is 

Fig. 3f 

 Click the arrow to proceed to the next menu 
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Income Taxes 
(By Center Only) 

Fig. 3g 

The following 
screen only applies 
if you are creating a 
By Center project. 
 
If you are creating a 
Total Bank project, 
you may skip to the 
Synchronize 
Historical Data 
section below. 
 
When creating a By 
Center Forecast 
this screen enables you to manage your income taxes at the individual Profit Centers or 
Consolidated at the primary profit center only. Select an option and click the 

 
arrow to proceed to the next menu. 

 

Synchronize  
Historical Data 
 

Use the drop down 
menu to select the 
date through which 
you’d like to 
synchronize data. 
 
This will populate 
your worksheet 
with the 
institution’s actual 
data. History will be 
populated starting 
with the beginning  Fig. 3h 

of the previous year and will populate all balances through the selected sync date. This 
allows you to see what your starting point and historical data are when you enter 
assumptions later. 

Click the 
 
arrow to proceed to the next menu. 
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Confirm 
Information 

Fig. 3i 

The final window 
provides you with 
the ability to verify 
all selections before 
you proceed with 
saving the project. 
It is important to 
verify this 
information as 
much of it cannot 
be changed once 
the project has 
been saved. 

To edit any settings that you wish to change, use the  arrow to navigate through  
the previous menus and correct the appropriate selection(s). Once you have confirmed 
that all settings are correct, click on Save to save the project and open the Smart Fill 
window. 

 
3.2 Smart Fill 

Smart Fill  

 

Fig. 3j 
In the Smart Fill window, you will see totals representing where the institution ended 
last year (December 2011 in the above example). Also represented is a column 
defining balances through the sync date (April 2012 in the above example). To 
proceed with your forecast, you must enter totals that represent where you want 
the institution to end the current year (December 2012 in the above example) and 
the following year (December 2013 in the above example). 
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To complete the form, click in the desired cell and enter a total for that line item. 
Dashboard will take the totals you enter and apply them to all of the accounts in the 
corresponding category based on the current mix. This alleviates you from the 
practice of manually entering data for every account at every profit center. For 
example, if you enter 300,000,000 in the December 2012 field for Loans, net of 

unearned income, the Dashboard will use that number to: 
a.) look at all of the loan types that you have defined in your G/L 

b.) calculate the percentage of the total associated with those loans 

c.) calculate a straight year growth for those loans, and 

d.) apply the total of 300,000,000 based on the current mix at both the G/L 

and Center level. 

 
Note: Once your project is complete, you will be given the opportunity to review and 
modify these numbers to more closely represent your ideal forecast. 

 
Once you have entered the desired totals for each line item, Click  
proceed to the Smart Fill confirmation screen. 

 to 

   

Fig. 3k 
After reviewing the balances, click Edit Balances to return to the previous screen, 
or click  to create your project. 
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In the confirmation window, select Next to 
confirm the amounts you have entered in 
the Smart Fill window. 
 
To verify or edit any amounts, click Cancel 
to return to the previous screen. 

  
Fig. 3l 

 

Preparing Project 
 
Once the preparing project window has 
appeared, you are finished creating your 
forecast. Verify that the email listed is 
correct and Select Close. 
 
Note that it may take several minutes for  

  
Fig. 3m 

your project to complete and for you to receive the email informing you that your 
project is ready to view. Once you have received confirmation that your project is ready, 
proceed to section 4 of this document. 

 

4 Opening and Viewing a Forecast 

 

4.1 Opening a Forecasting Project 

Once your project has been created and you have received an email confirmation that it 
has been processed, you can begin reviewing and modifying the resulting Balance Sheet 
and Income Statement. 

 
This section describes the Forecasting Window and the tools and options available for 
reviewing and modifying your project within the Forecasting tool. When analyzing your 
project, you may also wish to open the project in the G/L Reports section of Dashboard. 
For more information on viewing your project in G/L Reports, see Section 5. 
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To open the project, open Bankers 
Dashboard and navigate to Projections 
and click on Forecasting. 

 Fig. 4a 
 

In the Forecasting window, use the SELECT PROJECT drop down menu to select the 
title of the project you wish to open. Click on Open Project. 

 

Fig. 4b 

 This will open the primary Banker’s Dashboard Forecasting window (see Fig. 4c). 

4.2 Forecasting Window Overview 

Before you begin reviewing and modifying your forecast, there are a few things you 
must know about the forecasting tool. This section provides a general overview of the 
forecasting window to familiarize you with its general layout and the tools available 
within the project window.  
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Fig. 4c 

4.2.1 Navigation Window  
 

The navigation window is represented by the number 1 in Figure 4c. There are three 
primary parts to the navigation window: the navigation tree, the Balance Sheet tab, and 
the Income Statement tab.  

  Fig. 4d

 

When you open your project, the Balance Sheet tab 
is loaded by default and you are given three primary 
tree options: Assets, Liabilities, and Capital. 

 

To view the details for each account, click on the 
arrows beside the tree heading(s) to expand the 

account categories. Once you have expanded the account categories, click on the 
desired group to show the relevant data in the Modify Data Window. 
 
To view the headings and accounts related to your income statement click on Income 

Statement and follow the same logic to drill down through the navigational tree and 
select the desired account. 
 
For more information regarding the Income Statement and Balance Sheet tabs, see 
Section 5. 
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4.2.2 Modify Data Window  
 

The Modify Data window is represented by the number 2 in Figure 4c. It is the primary 
window of the forecasting tool and is where all account data is displayed for your 
project. This window has the look and feel of a budget worksheet and is where you 
begin to see and interact with the project details. 

In the example below, the navigation tree of the Balance Sheet tab has been expanded 
to show the Assets/ Fed funds sold & repos heading. The Federal funds sold heading 
has been selected and the accounts within the heading are displayed in the Modify Data 
window. 

                                                                                                                                                              Fig. 4e

 

One of the first things you will notice about the Modify Data window is that the 
numbers are color-coded. 

Black numbers represent actual data, or the numbers consistent with the sync 
date you selected using the Synchronize Historical Data window when you 
created the project (see Fig. 3h).  

Blue numbers represent those assumptions that you entered in the Smart Fill 
window when you created the project. These are the projected assumption 
totals you entered for the end of the current and next year when you created 
the project (see Fig. 3j). 

Smart Fill has used the totals you entered to calculate the monthly balances 
required to ensure that those annual totals are met. The resulting balances are 
represented by the Red numbers, which show the straight-line growth the 
system has calculated using those annual Smart Fill totals. 

You can use the scroll bar at the bottom of the window to scroll left and right through 
the data. This will take you from the beginning of your synced data (typically January of 
the previous year) through December of the coming year. 
 
While viewing the Balance Sheet, you can also use the  

 
and 

 
 symbols  

located beside the year-end months (typically December of the current and next year) 
to expand and collapse that year’s data for easier navigation. 

 

Once you are comfortable with the look and feel of the Modify Data window, you should 
read the next section to familiarize yourself with the tools menu.  
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Reading the following section will help you understand how to more accurately and 
easily modify data. It will also familiarize you with the tools available to restrict access 
to the project, resynchronize data, and add profit centers, in addition to other useful 
tools and information. 

 

For further information on using the Modify Data window, see section 5. 

4.2.3 Additional Tools  
 

The additional tools section is represented by the number 3 in Figure 4c. There are five 
primary parts to the tools menu: the File menu, the Tools menu, the Auto-fill tool, and 
the Undo tool. 

4.2.3.1 
 

The File Menu 

 Fig. 4f 

  

The file menu is where you create new projects, open an 
existing project, delete the current project, or close the 
forecasting window.  
 
Selecting New Project will open the Create New Project 

window (see section 3.1). 

Selecting Open Project 
opens the Open Project 
window from which you 
can select and open an 
existing forecasting 
project. 
 
Selecting Delete Project 
opens the Delete 

Forecasting Project 
window, where you can 
delete your current 
forecasting project. 

 Fig. 4g 
 

 Fig. 4h 
 
Selecting Close Forecasting will close the current forecasting window and return you 
to the Dashboard. 
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4.2.3.2 
 

The Tools Menu 

      
 Fig. 4i 
 

There are several options available in the tools 
menu. These options help you define certain 
project parameters and allow you to edit the 
current data assumptions of the project. Each 
option is discussed individually below.  
 
 
 

Tools Menu- Reconcile Project: 

 
Clicking Reconcile Project calculates income taxes, rolls retained earnings, and 
balances the project to cash. G/L Balance Sheet reports viewed during the 
modifications process will be out of balance until the project is reconciled.  

 

The project may be reconciled at any time to balance the project. 
 
 

Tools Menu- Synchronize Historical:  

 
Selecting Synchronize 

Historical opens the 
Synchronize Historical 
window. Your project has 
already been synchronized 
to the date you selected 
when you created the 

                                                                                                     Fig. 4j 

  

project (see Fig. 3h). Selecting this option allows you to change the date to which 
you synchronized the project. To re-sync your project, select the desired date from 
the drop-down menu and select Synchronize. 
 
Note: Re-syncing will change your previous numbers and you may want to create a copy of 

the current project and use that copy to sync to a new date. This will retain a saved version of 
your current project should you decide to return to the previous date. 
 
If you make changes to the G/L Account Mapping and want those changes to be reflected in 
your project, you must re-sync it. If you do not wish to change any other parameters of the 
project, you can re-sync to the same month. 
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Tools Menu- Smart Fill: 

 
Selecting Smart Fill opens the Smart 

Fill window (see Fig. 3j). This allows 
you to re-enter the totals that 
represent where you want the 
institution to end the current and 
following years and lets you to re-
enter your project assumptions 

 

 Fig. 4k 

using new projection numbers. You can go through this process as many times as 
necessary to reach your project goals. Once you have entered new numbers and 
clicked Next, you will receive a verification screen to ensure that you wish to 
overwrite the previous projected December balances. Click Next to continue, or 
Cancel to return to the previous screen. 

 

Tools Menu- Project Options: 

 
Selecting Project Options opens the Project Options window. There are four separate sections of 
this window: General, Loan Loss Allowance, Profit Centers, and Project History. 
 
1. General 
 
There are several settings available in 
the General section. Here, you can: 

 Re-name the project by 

entering a new name in the 

Project Name dialog box.  

 Choose whether or not to 

Balance cash at each profit 

center by selecting the desired 

Yes or No option. 

 Select a different Cash 

Balancing and/or Retained 

Earnings Account. 

 And choose whether      Fig. 4m 

to Round Income Taxes to 

the nearest $1, $100, or 

$1000. 

 

    Fig. 4m 
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2. Loan Loss Allowance 
 
The Loan Loss Allowance window 
allows you to verify settings for  
the: 
 
Loan Loss Allowance type, 
Beginning of Year Balance, 
Balance Sheet Provision, 
and Income Statement Provision 
accounts. 
 
Additionally, you can use the drop 
down menu beside Round Monthly 

Provision to select whether to round 
to the nearest $1, $100, or $1,000. 
 

    Fig. 4n 
 
 
3. Project History 
 
The Project History window allows you  
view any previous project history 
regarding the project’s: 
 
 
 
 
 
Sync Date, 
Smart Fill, 
Modify Date, and 

Generate Date. 
 
The window displays the date for each 
relevant section, as well as, the user 
who last modified each section. 
 
 
Once you have validated and/or 

 

    Fig. 4o 

updated any information within the Project Options window, you must click the 

 button to accept and save all changes and close the options window. 
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Tools Menu- Reporting Permissions: 

 
Selecting Reporting 

Permissions from 
the Tools Menu 
opens the Project 

Permissions 
window. 
 
Here, you can select 
who has the ability 
to see the current 
project as a data 
source in the G/L 

                                                                                                                   Fig. 4p 

  

Reports section of their Dashboard. By default the person who created the project 
is the only one who can view it in their G/L Reports. To modify this setting, select 
one of the radio buttons beside Only Me, Only Projections Admins, Everybody, 
or Select List. To select multiple users under the Select List option, you can hold 
down the Ctrl key on your keyboard while clicking on the appropriate name. 
 
When you are finished editing these settings, click Finished to close the 
permissions window. 
 

 
It is important to note that persons given access with this tool will only be 
able to view the project in their G/L reports and will not be able to change or 
edit the project. To allow a user to change or edit a project, see the following 
section on Project Edit Permissions. 

Note: Changing permissions here only restricts access to the current project and does not 

affect any additional forecasting projects. 

Tools Menu- Project Edit Permissions: 

 
Selecting Project 

Edit Permissions 
from the Tools 
Menu opens the 
Project 
Permissions 
window. 

 

Here, you can select 
who has the ability 
to edit the current 
project and to 
control which 
centers they can 
access and edit. To 

 
  Fig. 4q 
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modify this setting, select a user from the box on the left and then highlight the 
profit centers that you’d like to give them access to. You can hold down the Ctrl 
key on your keyboard while clicking on the appropriate name to select multiple 
profit centers. Note that the example in Fig. 4r is from a By Center project that list 
multiple profit centers. If you are providing access to a Total Bank project, only the 
ALL option will be available. 
 
When you are finished editing these settings, click Finished to close the 
permissions window. 
 
Note: Changing permissions here only restricts permissions for the current project and does 

not affect any additional forecasting projects. 
 
4.2.3.3 

 

Auto-fill 

Auto-fill provides a quick and easy way to copy data 
that you enter manually across and/or down to 
additional cells. By default, the arrows in the Auto-fill 
tool are grey. This indicates that the tool is not 

 

available in your current view. 
 
When the tool becomes available, the arrows will turn blue to indicate they are 
usable. When available, you can click on the desired arrow to initialize a copy down 
or right action. 
 
By navigating to a heading where the tool is available 
(below the Time Deposits – Wholesales/ CD’s 

Brokered section of the Income Balance Sheet). The   

tool becomes available and the across arrow turns blue. This indicates that the tool 
is available and may be turned on by clicking it once.  
 

 

When you click the blue arrow to turn on the copy action, 
it will turn green. This indicates that any cell in which you 
enter data will copy to all cells to it’s right (or to those 
directly underneath it if you are using the copy down 
arrow). 

 
In the following example, you can see that the percentage representing the 
BROKERED CD’S account was calculated by Smart Fill to be consistent with the 
actual percentage from the previous month (2.9566%). 

Fig. 4s 

 
 
Without the Auto-fill arrow selected, changing 2.9566% to a different percentage 
will not change any subsequent percentages: 
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Fig. 4t 

 

However, with Auto-fill selected and with the across arrow green, the changed 
percentage will copy across to all subsequent percentages for that account: 

 

 
Fig. 4u 

 

Undo 

Any changes you make to the modify data window that you do 
not wish to keep can be reverted using the Undo button. In the 
example immediately above, clicking the Undo button would 
revert the entry of the 3.1000% back to the original 2.9566%.   

The percentages would also revert to their original coded color to indicate whether 
or not they were calculated by the system or were entered manually. 

There is no limit to how many times you may click the Undo button to revert to a 
previous change, however, only changes made in the current session can be 
reverted. Once you log out all changes will be applied and the Undo button will be 
reset. 

5 Analyzing and Modifying Forecast Data 

 

5.1 Analyzing the Project 

After receiving an email from the Dashboard system informing you that your project is 
complete, you can analyze the results of your project and begin to verify the data for 
each account to ensure that you are satisfied with the system’s calculations. You have 
the option of either returning to your G/L reports to view your project, or view and 
modify data directly in the forecasting window. 

It is generally recommended that you use a combination of the two; viewing the project 
data in your G/L reports and using the Forecasting tool to modify data as needed. 

To view the 
project in your 
G/L reports, 
navigate to the 
Dashboard and 
click on G/L. This 
will open the G/L 
section of the 
Dashboard and 
will allow you to 
navigate through  

 
Fig. 5a 
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a list of the reporting options available. For example, you may wish to view a Balance 
Sheet Compare report, or a Margin Analysis Compare report. 

The following example shows a Balance Sheet Comparison. To view this report, 
navigate to G/L, click on Balance Sheet and select Compare. This will open the Balance 
Sheet 
Compare 
Window. Here, 
you can select 
your project 
using the drop 
down list under 
Source. You 
may also select 
specific months 
to compare and 
add additional  

 Fig. 5b 

 
 

columns to the comparison report using the Add button. When you are finished 
selecting all options, click on Show Report to continue. 

 
Once your report is open, you may click on the calculations and accounts listed to drill 
down and see more information (see Fig 5c). If you see information that you’d like to 
change, you can log into the Forecasting tool and change the relevant data. For further 
information on changing the calculations in the Forecasting tool, see section 5.2 below. 
 

Fig. 5c 

 

 

 
It is important to note that changes made to the data within the Forecasting tool 
are submitted immediately. If you are viewing a G/L report and you modify any  
data within the Forecasting tool without first closing the report, you must click  

 the  button located in the top right-hand corner of the G/L  
 report to update it and reflect those changes. 
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5.2 Modifying the Balance Sheet 

Begin by expanding each heading under the Balance Sheet and verifying the data under 
each account. Use the scroll bar at the bottom of the window to scroll left and right 
through the data. This will take you from the beginning of your synced data (typically 
January of the previous year) through December of the coming year. Scroll through the 
balance sheet and ensure that you are satisfied with each of the numbers Smart fill has 
calculated. 

 
If you would like to update or change a number, 
simply click in the cell and backspace to delete it. 
You can enter any number you like and the 
system will update all subsequent numbers to 
update the total monthly goals. This will change 
the number’s color code to blue, to indicate that 
is was a number you edited directly. 
 
For example, in Fig. 5d you can see the second 
number was changed from $10,838,125 to 
$10,870,000. This had no effect on the actual  
Number from the previous month ($10,815,000). 
 

    Fig. 5d 

 
 

 
 

 
 

However, the number that was manually entered changed to blue to indicate that it was 
edited. And, the system generated numbers to it’s right were updated to reflect the new 
monthly estimations that reflect the overall year-end goal. 
 
In addition, you can change the ending December balance assumptions and the 
Dashboard will recalculate the previous months based on the new ending balance you 
entered. 
 
Work your way through the Balance Sheet until you have adjusted any numbers 
necessary to reach the goals of your forecast. Look for any breaks in trends (i.e. 
numbers that look out of place, or were one time events) and normalize them by 
entering data manually. To save time, you can use the Auto-fill tool to help during this 
process. For more information on the Auto-fill tool, see section 4.2.3.3. 
 

5.3 Modifying the Income Statement 

To view your Income Statement, select the Income Statement tab in the Navigation 
menu (see Fig. 4c). The Income Statement calculates monthly rates for historical data, 
then uses the last monthly actual as the rate assumption going forward. 
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As with the Balance Sheet, you have the ability 
to modify these calculations by clicking in a cell 
and using the backspace key to delete the data. 
Enter the desired decimal number and the 
system will update the current percentage. This 
will change the percentage’s color code to blue 
to indicate that is was edited directly. 
 
In Figure 5e, for example, you can see that the 
second percentage was changed from 0.2224% 
to 0.2345%. This had no effect on the actual 
percentage from the previous month (0.2224%). 

Fig. 5e

 
 

 
 

 
 

However, the percentage that was manually entered has changed to blue to indicate 
that it has been edited. In addition, all of the percentages to the right have changed. 
This is only because Auto-fill was selected. If Auto-fill had not been selected, only the 
percentage edited would have changed.  
 
For more information on Auto-fill, see section 4.2.3.3. 
 
Note: You must enter percentages here as decimals (i.e. 0.002345 for 0.2345%). 
 
Work your way through the Income Statement until you have adjusted any percentages 
necessary to reach the goals of your forecast. Look for any breaks in trends (i.e. 
numbers that look out of place, or were one time events) and normalize them by 
entering data manually. 

 


